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Abstract

An increasing number of genetically modified mouse models has become available in recent years. Moreover, the number of pharmacological
studies performed in mice is high. Phenotypic characterization of these mouse models also requires the examination of cardiac function and
morphology. Echocardiography and magnetic resonance imaging (MRI) are commonly used approaches to characterize cardiac function
and morphology in mice. Echocardiographic and MRI equipment specialized for use in small rodents is expensive and requires a dedicated
space. This protocol describes cardiac measurements in mice using a clinical echocardiographic system with a 15 MHz human vascular probe.
Measurements are performed on anesthetized adult mice. At least three image sequences are recorded and analyzed for each animal in M-
mode in the parasternal short-axis view. Afterwards, cardiac histological examination is performed, and cardiomyocyte diameters are determined
on hematoxylin-eosin- or wheat germ agglutinin (WGA)-stained paraffin sections. Vessel density is determined morphometrically after Pecam-1
immunostaining. The protocol has been applied successfully to pharmacological studies and different genetic animal models under baseline
conditions, as well as after experimental myocardial infarction by the permanent ligation of the left anterior descending coronary artery (LAD). In
our experience, echocardiographic investigation is limited to anesthetized animals and is feasible in adult mice weighing at least 25 g.

Video Link

The video component of this article can be found at https://www.jove.com/video/55843/

Introduction

A large variety of genetically modified mouse models are available, and the number of pharmacological studies in mice is high1,2.
Echocardiography and MRI are commonly used approaches for the phenotypic characterization of cardiac function and morphology in these
mouse models3. The aim of the presented protocol is to analyze cardiac function and morphology in adult mice. It combines echocardiographic,
histological, and immunohistochemical measurements. Echocardiographic examination is widely used in mice4,5,6,7,8,9,10,11,12. Pachon et al.11

identified 205 studies published in Circulation, Circulation Research, American Journal of Physiology - Heart and Circulatory Physiology, and
Cardiovascular Research between 2012 and 2015 that used echocardiographic examination in animals.

Echocardiography is used to identify cardiac phenotypes in genetically modified mice5,6,13,14,15,16,17,18,19,20,21,22, as well as to analyze cardiac
function in chronic overload-induced hypertrophy, myocardial ischemia, and cardiomyopathy models in mice (reviewed in12). Improved
echocardiography equipment allows for the the standard measure of left-ventricular (LV) systolic and diastolic dimensions, tissue Doppler
imaging, myocardial contrast echography, and the assessment of LV regional function and coronary reserve12. Ideally, echocardiographic
examination should be performed in conscious mice to avoid the negative effects of anesthesia on contractile function, autonomic reflex control,
and heart rate11. Nevertheless, this approach is limited by the requirement to train the animals; difficulties in keeping the body temperature
stable; movement artifacts; stress; very high cardiac frequencies; and the requirement for at least two investigators to perform the experiment,
especially if a large number of animals are under investigation. Interestingly, a recent study reported no differences in echocardiographic
parameters in trained and untrained animals19. We perform echocardiographic measurements in anesthetized mice. Different anesthesia
protocols will be discussed below.

Although standard resolution echocardiography (>10 MHz) is sufficient to measure LV systolic and diastolic dimensions and cardiac function
in adult mice, the method is limited in its description of underlying structural phenomena. Thus, we combine the in vivo measurements with
histological and immunohistological analyses to measure, for example, cardiomyocyte diameter and vessel density. Other histological and
immunohistological investigations, such as the determination of proliferation, examination of apoptosis, infarct size measurements, determination
of fibrosis, and specific marker expression, can also be performed on the same type of processed tissue but are not the subject of this protocol.
The combination of in vivo echocardiographic examination with histological analyses provides additional insights into underlying structural
alterations. In an additional step, we can complete these measurements with molecular and ultra-structural investigations. Histological analyses
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not only complete the echocardiographic examination but also become indispensible when the resolution of echocardiography is not sufficient.
This is especially the case in models of genetically modified mice that are embryonic lethal23,24.

Protocol

The experiments described here were carried out in compliance with the relevant institutional and French animal welfare laws, guidelines,
and policies. They have been approved by the French ethics committee (Comité Institutionnel d'Ethique Pour l'Animal de Laboratoire; number
NCE/2012-106).

1. Echocardiography

1. Determine the body weight of the mouse using a standard laboratory balance while holding it lightly by the tail to ensure proper positioning.
2. Anesthetize the animal by the intraperitoneal (i.p.) injection of 50 mg/kg pentobarbital25,26.

 

NOTE: Any other kind of anesthesia can be used if the same protocol is used throughout the study. Advantages and disadvantages will be
discussed below.

3. Put the mouse back in its own cage and wait until it is unresponsive, it shows steady breathing, and rear foot reflexes are absent. To test this,
squeeze a foot slightly and observe whether the leg still retracts.

4. Shave the left side of the thorax and the left armpit using a commercial rodent shaver.
 

NOTE: The use of a dedicated rodent shaver allows for the complete removal of fine mouse hair to avoid interference in the
echocardiographic measurement. Commercial hair removal creams or solutions should be avoided, as they are usually perfumed, which will
disturb the animal after it awakens. Avoid excessive shaving, as it increases heat loss.

5. Put the sleeping animal on a warm pad set to 40 - 42 °C in a shallow left-sided position, with the head at 12 o'clock and the tail at 6 o'clock.
Fix the left arm, left leg, and tail with tape.

6. Apply pre-warmed echocardiography gel onto the shaved chest and the head of the transducer.
7. Place the transducer parasternal-left, directing it to the right side of the neck to obtain a two-dimensional (2D) parasternal long-axis

view on the level of the papillary muscle. Turn the transducer 90° clockwise to obtain a short-axis view at papilary muscle level. Use
a minimal depth setting and a zoom to maximize image quality and frame rate. Set the sweep speed to the maximum.

1. To obtain these settings, different zoom and depth setting options may be used, depending on the machine and software. Record 2D-
guided M-mode images in short-axis view27. Refer to Figure 1A and B27.
 

NOTE: Take care to avoid applying excessive pressure to the chest, as this may cause bradycardia.

8. Record at least 3 series of 3 heart beat cine loops for each animal.
 

NOTE: For the echocardiograph software used in this study, press the "Acquire/Save" button only once. This methodology is specific to the
echocardiograph with this particular software. Other software packages may be used with different machines.

9. After successful recordings, wipe off the echocardiography gel from the mouse thorax, heating pad, and transducer. Remove the tape from
the limbs and tail.

10. Leave the mouse under observation on the heating pad, covered with tissue to avoid unnecessary light exposure and heat loss, until it wakes
up.

11. Put the animal back in its cage.
12. Analyze recorded M-mode images from parasternal short-axis view to determine left ventricular (LV) dimensions and function. Measure the

thickness of the LV anterior wall in systole and diastole (LVAWs and LVAWd), the LV internal end-systolic and end-diastolic diameters (LVIDs
and LVIDd), and the LV posterior wall thickness (LVPW) in systole and diastole (LVPWs and LVPWd) using the identification of the tissue-
blood interface on the stored images.

13. Measure the diastolic dimensions at the time of the apparent maximal LV diastolic dimensions and LV end-systolic dimensions at the time
of the most anterior systolic excursion of the LV posterior wall. Tap the touchscreen on the "Analyze" icon and then on the "LVAWd" icon.
Position the electronic caliper on the interface between the right ventricular cavity and the LV anterior wall in diastole.

14. Position the electronic caliper on the interface between the LV anterior wall and the LV cavity to obtain the LV diastolic anterior wall thickness;
the software will directly switch to the LV internal end-diastolic measurement.

15. Position the caliper on the interface between the LV cavity and the LV posterior wall to obtain the LV internal end-diastolic diameter; the
software will switch to the LV posterior wall thickness measurement.

16. Position the caliper on the interface between the LV posterior wall and the pericardium to obtain the LV diastolic posterior wall thickness.
For LV systolic dimensions, tap the touch screen on the "LVAWs" icon and position the electronic caliper on the interface between the right
ventricular cavity and the LV anterior wall in systole.

17. Position the electronic caliper on the interface between the LV anterior wall and the LV cavity to obtain the LV systolic anterior wall thickness.
Repeat the process as described above for the LV internal end-systolic diameter and the LV systolic posterior wall thickness. Use the leading-
edge convention adopted by the American Society of Echocardiography to trace the endocardial and epicardial borders13,27.
 

NOTE: LV contractile function parameters will be automatically calculated using the previous measurements. The LV fractional shortening
(FS) is defined as FS (%) = [(LVIDd - LVIDs)/LVIDd] x 100. The LV ejection fraction (EF) is calculated with the modified Teicholz formula,
where EF (%) = [(LVIDd3 - LVIDs3)/LVIDd3] x 10012. Refer to Figure 1A and B.

18. Store the data on compact discs or USB memory sticks and make backup copies.
19. Import, analyze, and export the data using the appropriate software.

 

NOTE: After these baseline measurements, the experiment can be paused. If performing a direct comparison between knockout animals and
wild-type littermates, proceed with the histological analyses6. For Cre-ERT2; lox/lox mouse lines, continue the following day with tamoxifen
induction by i.p. injection, as described5,24. If inducing experimental myocardial infarction by the ligation of the left coronary artery5,28, the
surgery could be performed directly after the echocardiographic measurements, when the mice are under anesthesia. Otherwise, a minimum
delay of one week between two rounds of anesthesia should be maintained to limit the rate of post-operative lethality.
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2. Preparation of Heart Samples for Histological Evaluation

1. Sacrifice the animals by cervical dislocation. Measure their body weights. Disinfect the chest and abdomen using a 70% alcohol swab.
2. Make a transverse incision in the skin 1 cm distal to the sternum. Using blunt forceps, remove the skin from the thorax, moving in the

direction of the head. Hold the sternum lightly with fine forceps and open the diaphragm by inserting the blunt end of fine scissors.
3. Cut the rib cage on both sides parallel to the sternum. Move the sternum in the direction of the head. Locate the heart in the thorax. Hold the

vascular trunk of the heart with the fine forceps and cut below using fine scissors.
4. Open the chest and excise the entire heart out of the thorax, measure the heart weight, and establish a heart-to-body weight ratio4,5,6,23,29,30.
5. Fix the heart in 2 mL of 10% neutral buffered formalin solution in 15-mL tubes overnight at 4 °C.

 

CAUTION: Danger! Work with formalin solutions must be done in a chemical fume hood; wear gloves and safety glasses.
 

NOTE: As the buffer composition for formalin solutions varies with different suppliers, use the same supplier throughout the study.
6. The next day, cut the hearts in the transverse plane, in the middle, and transfer them into cassettes for paraffin embedding, which is

performed in the pathology laboratory using an automated embedding apparatus.
7. Perform sectioning.

1. Section paraffin blocks at a thickness of 3 µm using a microtome and float them in a 40 °C water bath containing distilled water.
2. Transfer the sections onto slides. Allow the slides to dry overnight in a 37 °C incubator and store them at 4 °C until ready for use.

 

NOTE: The protocol can be paused here until the user is ready for staining (step 3).

8. Deparaffinize and rehydrate the tissue slides.
1. Place the slides in staining jars with glass inserts in a 55 °C oven for 10 min to melt the paraffin.
2. Deparaffinize the slides in two changes of 200 mL of xylene or xylene substitute for 5 min each.

 

CAUTION: Highly flammable and toxic! Work in a chemical fume hood; wear gloves and safety glasses.
3. Transfer the slides to 200 mL of 100% alcohol. Make two changes for 3 min each and transfer once through 200 mL of 95% alcohol for

3 min.
 

CAUTION: Highly flammable! Keep away from sources of ignition; no smoking.
4. Rinse twice in 200 mL of phosphate-buffered saline solution (PBS) for 5 min each and continue with step 3, 4, or 5.

3. Hematoxylin and Eosin Staining

1. Rinse the slides with their sections in distilled water.
2. Stain the nuclei with hematoxylin solution for 8 min.
3. Rinse in running tap water for 10 min.
4. Stain with eosin solution for 2 min.
5. Dehydrate three times for 2 min in 100% ethanol (EtOH). Clear three times for 2 min in xylene or xylene substitute. Mount in a xylene-based

mounting medium.
6. Photograph the slides and measure the cardiomyocyte diameter at the level of the nucleus in longitudinal sections of the interventricular

septum. Measure at least 100 cells per section and three sections per heart.

4. WGA Staining

1. Incubate the slides obtained from step 2.7 with tetramethylrhodamine (or other fluorescent dyes)-conjugated WGA (1:100 in PBS) for 60 min
at room temperature in a humid chamber.

2. Wash three times with PBS for 5 min each.
3. Mount with fluorescence mounting media containing DAPI. Store at 4 °C in the dark before analysis.

 

CAUTION: Wear eye protection and compatible chemical-resistant gloves.
4. Photograph the slides.

1. Use a microscope equipped with fluorescence epi-illumination and filter sets for DAPI and tetramethylrhodamine (refer to the Table of
Materials). Set the aperture to the maximum and the brightness to auto-exposure.

2. Acquire separate images at 400x magnification for the blue and the red channels. Open the images in ImageJ. Adjust the brightness
and contrast if necessary (Image > Adjust > Brightness/contrast).

3. Set each image to 8-bit (Image > Type > 8-bit). Overlay the DAPI and WGA images. Use the blue channel for DAPI and the red
channel for WGA; set the green and gray channels to none (Image > Color > Merge channels)31.

5. Determine the cardiomyocyte diameters at the level of the nucleus in transverse sections of the interventricular septum.
1. Define the scale of the images in ImageJ. For this purpose, photograph an object of known size (e.g., a hemocytometer chamber at the

same magnification as the heart sections; step 4.4).
2. Use the straight-line tool to draw a line from beginning to end of the known structure (Analyze > Set scale).

 

NOTE: The distance in pixels will be displayed automatically; the known distance and unit of length will have to be entered. Proceed
with cardiomyocyte measurements at the level of the nucleus.

3. Draw a straight line from the WGA-positive membrane through the DAPI-positive nucleus to the opposite site of the WGA-positive cell
membrane (Analyze > Measure). In the results window, make sure that the length values have a meaningful number of decimal places
(Analyze > Set measurements > Decimal places).

4. Measure at least 100 cells per section and three sections per heart. Export the results to Excel (Click on Results > File > Save as
> .csv)6,31.
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5. Pecam-1 Immunostaining

1. Perform antigen unmasking.
1. Add 1,600 mL of sodium citrate buffer (10 mM sodium citrate, 0.05% Tween 20, pH 6.0) to a pressure cooker. Place the pressure

cooker on the hotplate and turn it on full power. Do not secure the lid of the pressure cooker at this point; simply rest it on top.
 

CAUTION: Hot!
2. Once the sodium citrate buffer is boiling, transfer the slides from step 2.5 to the pressure cooker. Secure the pressure cooker lid. As

soon as the cooker has reached full pressure, wait for 7 min. When 7 min have elapsed, turn off the hotplate and place the pressure
cooker in an empty sink. Activate the pressure release valve and run cold water over the cooker. Once it has de-pressurized, open the
lid and run cold water into the cooker for 5 min. Place the slides in 200 mL of PBS.
 

NOTE: Alternatively, microwave antigen unmasking could be used, although the risk of overheating is increased.

2. Use 0.3% hydrogen peroxide in methanol to block endogenous peroxidase activity for 5 min. Rinse the slides for three times for 2 min each in
200 mL of PBS.
 

CAUTION: Flammable and toxic!
3. Incubate the slides for 15 min in diluted normal blocking serum (5% normal goat serum in PBS) that also contains an avidin block (4 drops in

1 mL).
4. Carefully tap the liquid from the sections and incubate them with Pecam-1 antibody from rabbit, diluted 1:50 in PBS containing 2.5% normal

goat serum and 4 drops of biotin block per mL. Incubate the slides overnight in a humid chamber at 4 °C.
5. Wash the slides three times for 5 min each in 200 mL of PBS. Incubate the sections with biotinylated goat anti-rabbit IgG antibody diluted

1:200 in PBS containing 2.5% normal goat serum for 1 h at room temperature. Wash the slides three times for 5 min each in 200 mL of PBS.
6. Incubate the sections with an avidin/biotin-based peroxidase system for 20 min (reagent A and reagent B need to be combined 30 mins prior

to use). Wash the slides three times for 5 min each in 200 mL of PBS.
7. Dissolve 1 3,3'-diaminobenzidine (DAB) and 1 urea hydrogen peroxide tablet in 5 mL of double-distilled water. Incubate the sections with

DAB solution for approximately 3 min, carefully monitoring color development. Stop the color reaction by gently washing the slides in 200 mL
of PBS.
 

CAUTION: Carcinogenic; wear chemical-resistant gloves!
8. Counterstain the nuclei for 6 min with hematoxylin. Rinse in running tap water for 2 min. Dehydrate three times for 2 min each in 200 mL of

100% alcohol. Clear three times for 2 min each in 200 mL of xylene or a xylene substitute. Mount in a xylene-based mounting medium.
9. Photograph the slides (at least ten fields at 40x magnification from the interventricular septum of each heart) and measure the Pecam-1 area

density using the freely available ImageJ software31. Use the color deconvolution32 plugin for DAB and hematoxylin and adjust the image
contrast to the same level.
 

NOTE: In case the brown and purple/blue color have significant spectral overlap, which might cause difficulties with color deconvolution, one
could try different brands of hematoxylin solution to obtain clear, light-blue nuclear staining. Alternatively, immunofluorescence or manual
counting of the capillaries could be performed.

Representative Results

In Figure 1, representative echocardiographic recordings demonstrate the usefulness of echocardiography to identify cardiac phenotypes in
genetically modified mice. The difference between a mouse with normal cardiac function (Figure 1A) and an animal with a dilated left ventricle
and reduced LV function (Figure 1B) can easily be identified. Figure 2 shows the comparison of cardiomyocyte diameter measurements
in animals without (Figure 2A) and with cardiac hypertrophy (Figure 2B) using hematoxylin-eosin-stained paraffin heart sections and
measurements of longitudinal sections of heart tissue. Figure 3 illustrates the measurement of cardiomyocyte transverse diameters using WGA-
stained paraffin sections from hearts of control mice (Figure 3A) and animals with cardiac hypertrophy (Figure 3B). Figure 4 depicts the utility
of Pecam-1 immunohistochemistry (DAB substrate, brown staining) of cardiac sections to determine the vessel density of normal heart tissue
(Figure 4A) and hearts with increased angiogenesis (Figure 4B).
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Figure 1: Standard-resolution echocardiography (>10 MHz) to measure LV systolic and diastolic dimensions and cardiac function in
mice with dilated cardiac hypertrophy after myocardial infarction versus control animals.
 

Representative echocardiographic recordings from normal, healthy mice (A) and animals with LV dilation and reduced LV function after
myocardial infarction (Tie2-CreERT2; PPARβ/δ + Tamoxifen mice)5 (B). The LVAW, LVID, and LVPW are indicated. The white bars represent
systolic and diastolic measuring points. They correspond to the cursor points set for measurements and are explained in protocol step 1.12.
Please click here to view a larger version of this figure.

 

Figure 2: Hematoxylin-eosin-stained sections to measure cardiomyocyte diameters in longitudinally sectioned cells of mice with
dilated cardiac hypertrophy and control animals. Representative images of cardiomyocyte diameters in mice with normal cardiomyocyte
sizes (A) and animals with increased cardiomyocyte sizes (Tie2-CreERT2; PPARβ/δ + Tamoxifen mice)5 (B). The black lines indicate the
measured diameters. The values for each measurement are represented. Scale bars =50 µm. Please click here to view a larger version of this
figure.
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Figure 3: WGA-stained sections to measure cardiomyocyte transverse diameters in sections of heart tissue from mice with dilated
cardiac hypertrophy versus control animals. Representative images for cardiomyocyte diameters in mice with normal cardiomyocyte size (A)
and animals with increased cardiomyocyte sizes (Tie2-CreERT2; PPARβ/δ + Tamoxifen mice)5 (B). Nuclei were counterstained with DAPI. The
white lines indicate the measured diameters at the level of the nuclei (blue). The values for each measurement are represented. Scale bars = 50
µm.  Please click here to view a larger version of this figure.

 

Figure 4: Pecam-1 immunolabeled sections to analyze cardiac vessel density in control mice and animals with increased
angiogenesis.
 

Representative images for vessel labeling in mice with normal vascular density (A) and animals with enhanced vascularization (Tie2-
CreERT2;PPARβ/δ + Tamoxifen mice)5 (B). Nuclei were counterstained with hematoxylin. The arrows point to Pecam-1-positive vessels. Scale
bars = 50 µm. Please click here to view a larger version of this figure.

Discussion

Different methods have been developed to evaluate cardiac structure and function in mice, including echocardiography, contrast-enhanced MRI,
micro CT, and PET scan. Due to its cost-effectiveness and simplicity, echocardiography is the most widely used technique for functional analysis
in mice11. In general, because of the small size of the heart and the high frequency of the heart rate in mice, transducers with a frequency >10
MHz should be used, although successful measurements have been reported with 8 or 9 MHz transducers4,7. As cardiac function is closely
related to body temperature and cardiac frequency, it is important to control these parameters throughout the study. Placing the mouse on a
heating pad is essential to keep the body temperature of the anesthetized animal constant. Ideally, a controlled heating pad with a rectal probe to
set the body temperature to 38 °C should be used. If this is not available, the heating pad should be set to two to three degrees above this value.
Heating lamps should be avoided, as they complicate the task for the investigator and risk overheating the animals.

To control heart rate and cardiac function, the type of anesthesia is highly important. Most studies use isoflurane, as anesthesia is easy to
induce by inhalation in an induction chamber (3% isoflurane), can be maintained via an inhalation mask (1-2% isoflurane), and is only of
short duration. Other commonly used substances are 2,2,2-tribromoethanol, pentobarbital, and ketamine+xylazine mixes11,12. Surprisingly,
isoflurane has been reported to compromise cardiac function in echocardiographic measurements, and this effect was even more pronounced
in the ketamine+xylazine group11. Ketamine alone worked best in this study11. Gao et al. reported the most reproducible results with 2,2,2-
tribromoethanol12. The results were in the same range for isoflurane, 2,2,2-tribromoethanol, and pentobarbital12. Also, heart rates were not
different in the 2,2,2-tribromoethanol and pentobarbital groups12. Heart et al. reported lower heart rates in the ketamine+xylazine group
compared to the 2,2,2-tribromoethanol group16. In our experiments using different transgenic mouse strains and pentobarbital anesthesia,
the mean heart rates ranged between 350 and 450 bpm. Nevertheless, ejection fractions were >80%, which corresponds to the values in
conscious animals11. Echocardiographic measurements under baseline conditions from our laboratory4,5,6 are in the same range as reported
elsewhere11,12,14,15,16,17,18,19,20,21,22,26. In contrast to pentobarbital, ketamine, isoflurane, and 2,2,2-tribromoethanol are characterized by rapid
onset and recovery. Thus, the timing between anesthesia and the echocardiographic measurements should be the same for all animals in the
study to avoid different degrees of recovery from anesthesia. Pentobarbital acts longer, but has the disadvantage of a small therapeutic window,
making it necessary to adjust the dose tightly with respect to body weight. The long-lasting anesthesia using pentobarbital has the advantage
that, after baseline echocardiographic measurements, surgical procedures can be performed without the need for re-injection5. Repetitive
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anesthesia using pentobarbital should be avoided as, in our experience, injections with an interval of less than one week resulted in increased
postoperative mortality.

When performing echocardiography in mice with a >10-Mhz transducer, the quality of the pictures should be sufficient to determine global LV
function. Several pictures must be taken for each animal to reduce beat-to-beat variations and movement artifacts. Expert advice from a trained
cardiologist or a scientist with experience in echocardiography in mice should be asked at the beginning to evaluate the quality of the images.
Most echocardiography machines calculate EF from LV internal diameters using the Teicholz formula11,12. Even when LV dimensions are easy
to measure, they provide an imperfect assessment of LV volumes and areas because the LV does not conform to any ideal, simplified geometric
shape. Neither fractional shortening nor ejection fraction obtained with the Teicholz formula is a perfect parameter to determine LV contractile
function, as they are both based on a geometrical assumption and describe the contractility of only two walls. Ejection fraction assessed with the
biplane Simpson's method would be more accurate, but this was impossible to obtain in every animal with the equipment used here.

After myocardial infarction, we faced several problems related to the echocardiographic imaging. First, image quality was greatly hampered
by the thoracotomy scar. Second, animals were much more sensitive to repeated anesthesia. Finally, M-mode-based LV volume and function
measurements assume that LV geometry is homogeneous. As a consequence, the use of these indices becomes more controversial in the
presence of LV wall motion abnormalities after myocardial infarction.

In our hands, the use of a 15-MHz probe allowed for the occasional, but not systematic, recording of Doppler images. Much higher frequencies
are required to determine LV regional function or to perform myocardial contrast echocardiography, which can only be obtained with equipment
dedicated to rodents12.

Given the additional possibilities and higher resolution of those rodent-specific systems, one should consider using them in the future.
Disadvantages are the higher costs and the need of a dedicated space. These high-end, rodent-dedicated echocardiographs will be profitable
only if enough animals are under investigation and a critical number of scientists use the equipment. With the special training offered for these
machines, they can be used by scientists not expert in cardiology. The clinical echocardiography equipment provides a limited resolution, as
mentioned above. Nevertheless, it is still successfully used in different experienced laboratories11,12; can be easily used by skilled scientists and
cardiologists; is more mobile and less demanding on a dedicated space; and, due to the high number of machines, allows for the consideration
of different options to reduce costs (e.g., renting, obtaining equipment that is not in clinical use, or making secondhand purchases).

For histological analyses, the first critical point is to minimize the time between organ isolation and fixation of the tissue. As in this protocol, most
staining and histological analyses are based on transmitted light microscopy; immersion fixation of the heart tissue in formol is sufficient. If the
focus of a project is more on fluorescence microscopic staining, one should consider the perfusion fixation of anesthetized animals to remove the
red blood cells from the tissue, which show bright auto-fluorescence.

To avoid variations in the paraffin embedding, we use an automated embedding apparatus. As the melting point and hardness differ between
brands of paraffin, we recommend using the same supplier throughout the study. Paraffin sectioning should be performed on pre-chilled blocks
using a rotary microtome. Section thickness must be kept constant. A 3-µm section thickness allows clear visualization of membrane borders
in hematoxylin-eosin-stained heart sections, which is required for the accurate measurement of cardiomyocyte diameters. As the shape of
cardiomyocytes is irregular, measurements must be performed on the level of the nucleus. WGA staining provides an alternative way to stain the
cell membrane and will result in the same values as hematoxylin-eosin staining. Before morphometric analyses, one should clearly define which
part of the heart (i.e., left or right ventricular free wall or septum) will be measured and whether cardiomyocyte cross-sections are determined
in the long or short axis. Due to the transverse, spiral, and longitudinal orientation of cardiomyocytes in the heart, it is possible to obtain on the
same transverse section longitudinal and transverse sections of cardiomyocytes. Whether longitudinal or transverse diameters are measured is a
matter of convention, as long as the cells are analyzed at the level of the nucleus.

In our studies, we observed an agreement between the echocardiographic dimensions and the heart-to-body weight ratios and cardiomyocyte
sizes4,5,6, but histological measurements of cardiomyocyte size do not always correspond to the values of the ejection fraction. For example,
exercise training results in increased cardiac dimensions, with a preserved ejection fraction and increased cardiomyocyte diameters. However,
decompensated heart failure is characterized by increased cardiac dimensions, with a reduced ejection fraction and increased cardiomyocyte
diameters33. Furthermore, we recently showed that increased cardiac vessel density due to endothelial-specific overexpression of PPARβ does
not result in improved cardiac function under baseline conditions, nor in enhanced recovery after myocardial infarction5.

For immunohistochemistry, it is important to include negative controls and to perform the different blocking steps provided in the protocol. The
antigen unmasking step in the protocol is specific for the primary antibody used. For different primary antibodies, it is necessary to determine
whether low- or high-pH unmasking buffers result in a better signal. Different fixation techniques might be used to detect a specific antigen. For
example, Pecam-1 labeling has been reported to work best on Zinc-fixed, paraffin-embedded tissue, while the same fixation required additional
steps to reduce background for a thrombomodulin antibody34. Thus, we use regular formalin fixation, which allowed for extending the study to a
variety of different antigens. Alternative to Pecam-1 immunostaining, isolectin B4 is frequently used to visualize vessels. Besides a proportion of
endothelial cells35, isolectin B4 labels also glia36 and macrophages37. Furthermore, a variety of antigens might be used to distinguish between
arterial and venous endothelial cells38. An elegant way to visualize functional perfused vessels or to determine vessel sprouting or regression
is the intravenous injection of fluorescence-coupled lectin followed by the analysis of cryosections24. However, this approach largely limits the
possibilities to detect additional antigens and to perform morphometric analyses due to the different quality of the cryosections.

On immunostained sections where the signal is visualized with DAB, the area density can be quantitatively determined using the freely
available ImageJ software. However, as the signal is not linear, the degree of brown staining does not exactly correspond to the level of protein
expression.
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